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Requirements and Installation

System and Additional Software Requirements
1. Windows: Windows 95, 98, ME, NT4 or 2000, having a Pentium II

processor or better, and at least 64 MB of RAM. Macintosh: Any
Macintosh Power PC running MacOS 8.5 through 9.1 with at least 64
MB of free RAM. (A G3 or G4 is recommended.)

2 .  Macintosh only: QuickTime for playback through computer must be
installed (available from www.quicktime.com).

3. Macintosh only: Open Music System (OMS) is used to manage all of Igor
Engraver’s MIDI traffic. OMS is a freeware utility written by Opcode,
Inc. and is available for download from www.noteheads.com. (You will be
able to create files in Igor Engraver without OMS, but it must be
installed to hear playback.)

4. Any Postscript or QuickDraw printer is needed for printing.
5. Adobe Acrobat Reader 4.0 or later, available from www.adobe.com, is

needed to read the Igor Engraver manual.
6. If downloading Igor Engraver from the Internet, you will need StuffIt

Expander from www.aladdinsys.com to open the installer.

Installation of Igor Engraver
1. From either the CD or the downloaded file, double click on the Igor

Engraver Installer.
2. An installer window appears. Press Next/Continue.
3. The next screen is the Licence Agreement. If you have read, understood

and agreed with the text, press Yes/Agree.
4. Options for installation might follow. Choose Easy Install (recommended)

to install the full version of Igor Engraver. To install only a few files,
choose Custom Installation.

5. Select a folder for Igor Engraver. Press Next/Install.
6. A personalisation window might appear. Fill in the fields and press Next.
7. Depending on what system to use, a few more windows might appear.

Simply follow the instructions.
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8. Finally, a window appears that reads “Installation was successful …” or
the like. Press Restart.

9. Now, you will find a folder named Igor Engraver where specified.

Setting up OMS (Macintosh only)
(NoteHeads does not give technical support for OMS, since it is not our
application, but the steps below should get you started, if you don’t already
have OMS installed. This is covered in more detail in the Igor Engraver
manual.)
1. Double-click on the OMS Setup icon in your Opcode folder.
2. Under File, choose New Studio Setup, and click OK.
3.  A screen for OMS Driver Search appears. Press Search and OMS will

search for all MIDI input and output devices.
4. Click OK and OMS will identify these devices. Click OK once again.
5. Name your setup and save it.
6. If you have a red X through the QuickTime option, double-click on it. A

palette that reads “Configure QuickTime Synth” appears. Click on the
Yes option and click OK. The red X disappears and QuickTime is now
your current synthesizer. If you do not want to use QuickTime, select the
one you desire.

7. From the Studio menu, choose the Test studio command and click on the
QuickTime icon and/or other synthesisers’ icons. If you hear sound, your
setup is correct and OMS should work with Igor Engraver. Save your
configuration.

Setting up Igor Engraver
1. Double-click on the Igor Engraver icon.
2. A window might appear in which you will be asked to personalize your

copy of Igor Engraver. Please enter all information and click OK.

READ MORE: Igor Engraver Manual, Chapter 1
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Creating an Empty Layout

Starting a New Piece
1 .  From the File menu,

choose New Piece or
type Ctrl-N (Win) or
A– N  (Mac) on the
keyboard. An empty
Piece window appears.
It has the words “Never
Saved” on the title bar.
N o t e  t h a t  t h e
Macintosh version (top
r igh t )  and  th e
Windows  ve r s ion
(bottom right) of the
Piece window differ
slightly.

2. The Piece window has two panes: the left side for Layouts and the right
side for Musicians.

3 .  O n  t h e
bottom of
the Layout
s ide  the
following
icons appear
(from left to
right):
Score, Part
and
Settings.
The
Windows
version also

   Score     Part   Settings    Musician          Trash

Score  Part  Settings  Trash   Musician  Change instruments

Add Musician
Remove Musician
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has a Layout Trash icon. On the bottom left of the Musician pane there is
a Musician icon and to the far right a Trash icon. The Windows version
has an additional icon: Change Instruments. You are now ready to choose
the musicians who will be part of your piece.

Choosing Your Musicians
1. On the Macintosh: From the Windows

menu, choose Instrument Library or
press A-I on the keyboard; under
Windows: click on the Musician icon
once. A window appears that has the
word “Instruments” on the title bar.
Here you find instruments for creating
your new piece. They are separated
into these categories: Woodwinds,
Brass, Percussion, Vocal, Plucked,
Keyboard and Bowed Stringed
Instruments. Click on the plus or the
triangle icons to display all the
instruments in the desired category.

2 .  Find the first instrument that you
would like to appear in your piece, and
click on it. On the Macintosh,  drag it to the Piece window and drop it
on top of the Musician icon; under Windows, click Select.You have now
created a Musician, and a part layout for your musician has
automatically been added. All music information (notes, dynamics,
articulations, etc.) will be stored with the musician. This means layouts
can be deleted and you will NOT lose the information for that musician.
(Also, this means that, on the Macintosh, changing the instrument of a
musician is as easy as dragging the musician’s existing instrument to the
Trash icon and dragging a new instrument to the musician from the
Instrument library. Under Windows, select a musician and click the
Change Instruments icon to make your changes via the Instrument
library.) You can create multiple layouts for the same musician by
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dragging it to the Part or the Score icons (Macintosh) or clicking the
Layout icon with the musician selected (Windows).

3. Now, create another musician. A part layout appears for this musican as
well.

4 .  Observe that musicians can be added to or removed from existing
layouts. On the Macintosh, this is achieved by dragging the musician(s)
to the desired layout’s name, or from the layout to the Trash icon. To
add one or several musicians under Windows, select the musician(s) and
the desired layout(s), and then press the Add Musician icon. To remove a
musician from an existing layout under Windows, simply select it and
press the Remove Musician icon.

5. To save your composition, click on the Piece window and under the File
menu choose Save, or press Ctrl-S (Win) or A-S (Mac).

Creating Your Piece Settings
1. Next we will create Piece Settings. (Once created, these can be exported

for use in another piece.) From the Edit menu, scroll down to Settings for

“the name of your piece”. When this window opens, you will see the
Piece Information pane. Fill in all relevant information. If you need more
than one line for a category, press Alt/Option-Return and you will get an
additional line for text.

2. When you have completed this information, click on the menu that says
“Piece Information” and scroll down to General. Fill in or choose all
relevant information. (Although it can always be changed later, we
recommend that you choose the proper paper size.)

3. Feel free to go through the other panes and make the changes you want.
4. The settings for layouts, musicians, and instruments can be accessed by

dragging the icons to the Settings icon (Macintosh) or by selecting an
item and clicking on the Settings icon (Windows).

Creating Your Score
1. Let’s create a score. In the Piece window, click on the word “Musicians”

(Macintosh) or choose Select all from the Edit menu (Windows). All
musicians are now highlighted.
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2. Click and drag the highlighted musicians to the Score icon (Macintosh)
or click on the Layout icon (Windows). You now have a score layout, in
addition to the part layouts that were created previously. If you would
like to create a score or part for only some of the musicians, Shift-click
the musicians you want and drag and drop on (Macintosh), or select
(Windows), the Score icon or the Part icon.

3. Double click on the word Score in the Layouts pane. You will see your
title page. (If you open a part, there will be no title page.) Move to the
second page and you will see the first page of music.

4. Per default, all part layouts begin with a 32 multiple bar rest. Under the
Layouts menu, select Unconsolidate, or press Ctrl-U (Win) or A-U (Mac) to
unconsolidate the multiple bar rest.

Composing
The Tools Palette: A Quick Overview
Below is an overview of the Tools Palette to the far left of your screen. You
can use the Tools palette options to add an item to the score or parts at any
time. This is easy: just click on one of the pop-up palettes (such as the
Articulations tool) and after having chosen your desired symbol, click where

System tool

Key Signature tool

Notes and Rests tool

Articulations tool

Dynamics tool

Text tool

Glissando and Arpeggio tool

Harp Diagram tool

Wien tool

Magnifier and Hand tool

Clef tool

Metre tool

Accidentals tool

Attachments tool

Barlines tool

Tie tool

Noteheads tool

Fingerings tool

Guitar Fingerings/Articulations tool

Arrow tool

READ MORE: Igor Engraver Manual, Chapters 2, 5, 6
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you want it to apply (e.g., click on a note to input an articulation). As score
layouts and part layouts work together, if an item is added to a score it will
be added to the part; if added to a part, it will be added to the score.

Start to Compose
1. Click on the Key Signature Tool. Click in the middle of the first bar.

Use the mouse to choose your key type and the up/down arrows to select
the actual key.

2. Click on the Metre Tool. Click in the first bar and type in your metre.
(Notice the C/Cut check box. If you are in 4/4 and this box is checked, a
C will appear as the metre. To get cut time, set the metre to 2/2 and
check the box.)

Note and Rest Entry
1. Click on the Arrow Tool.
2. Double click in the first bar. A blinking Input caret

will appear in the bar. A small window titled Music
Entry will appear to the left. This window will tell
you the current pitch, the dynamic marking, the
note value, articulations, etc. When the window and
the Input caret are present, you are in Input mode.

3. To change the note value in the Music Entry window, use the numbers
on the keyboard. Each number represents a different note value:

Key 0 1 2 3 4 5 6 7 8 9
US

name 128th 64th 32nd 16th 8th Quarter Half Whole Double
Whole Longa

UK
name

Semi-
hemi-
demi-
semi-
quaver

Hemi-
demi-
semi-
quaver

Demi-
semi-
quaver

Semi-
quaver Quaver Crotchet Minim Semi-

breve Breve Longa
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4. To insert a note, choose the note value you want and press Enter (not
Return), or press Space to insert a rest. To switch pitches use the arrow
keys. A note or rest can be deleted using Backspace.

5. To add a dynamic after note entry, press the letter that corresponds to the
dynamic you want. For forte press F; for piano press P, etc. If you have
entered the wrong dynamic, press Backspace. Igor Engraver will then
delete it.

6. To add an articulation, type the articulation you would like to appear
(articulations will continue until you press the same articulation again).
. (period) = staccato

> = marcato accent
_ (underline) = tenuto
c = crescendo. (The crescendo will continue until you tell Igor Engraver
to stop. To end the crescendo, press C again. The crescendo can also be
stopped by pressing D, to start a decrescendo.)

7. Slurs work the same way, but use the letter L.
8. To sharpen or flatten pitches, press + or -.
9. To add an augmentation dot, press , (comma). Additional dots can be

added by pressing Ctrl-, (Win) or A-, (Mac). Press , (comma) to remove.

Moving items
1. Click on any object in a layout. A circle or other figure will show it is

selected.
2 .  You can drag with the mouse, move with the arrow keys or use

Alt/Option-arrow to move it 1/10 of an arrow click. (This can be changed
to be smaller or larger in Piece settings.)

Adding bars
Per default, Igor Engraver begins every piece with 32 bars. When you input
music and reach the end of bar 32, Igor Engraver will automatically create
more bars. If you know how many bars your piece will be, you can go to the
Edit menu and choose Add/delete bars…. In the window that opens, you can
choose to set a specific number of bars, to add or delete a specified number of
bars, or to delete empty bars in the end of the piece.



– 11 –

Note Shortcuts
1. Like the Enter key, the function keys also enter notes, but you do not

need to use the arrow keys to enter pitches.
2. Pressing F1 inputs a C in the current octave, F2 a D, etc. F8 inputs a C an

octave higher. F9 brings the input caret’s cursor an octave down and F10

an octave higher. Pressing the Ctrl key (Win) or the Command (A) key
(Mac) with a function key enters a sharpened pitch; the Alt/Option key
(B) with a function key enters a flattened note.

Editing in Input Mode
In Input mode, you can insert any kind of symbol available in Igor Engraver.
All of the available options are found in the Input menu, which is on the title
bar when you are in Input mode (double-click on a staff to enter Input
mode). The basic functionality of Input mode, as well as some of its most
useful features, are described below:
•  Moving the Input caret: Move the Input caret one entry to the left or

right by pressing the appropriate arrow key. If the Ctrl (Win) or
Command (Mac) key is held down whilst an arrow key is pressed, the
Input caret moves an entire bar at once. Move the Input caret vertically
(one staff at a time) by holding down the Alt/Option key whilst pressing
the up or down arrow keys.

•  Adding symbols to several entries: Articulations, crescendos, slurs, etc.
can be added to a group of notes by using the left and right arrow keys
along with the Shift key. Press the entry you desire and it will be applied
to all objects highlighted.

•  Deleting several entries: You can delete several objects by highlighting
them (as explained above) and pressing Backspace. If dynamic markings
are present, they will be deleted first.

READ MORE: Igor Engraver Manual, Chapters 2, 3, 6, 7, 8
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• Copy and paste: Highlight a section of music, then under the Edit menu,
choose Copy or press Ctrl-C (Win) or A-C (Mac). You can paste where you
place the cursor by choosing Paste from the Edit menu or pressing Ctrl-V

(Win) or A-V (Mac). Note that you can also copy music from one layer
(see below) and paste it into another layer.

• Transposing: Highlight a section and use the up and down arrow keys to
move the pitches up or down, or press Ctrl-T (Win) or A-T (Mac). You
will then be given options for transposing.

• Entering chords: After entering a note, use the arrows to move to the next
pitch you would like. Press Shift-Enter and an additional note will be
added to make a chord. Continue using the arrows and Shift-Enter until
your chord is complete. If the same chord repeats on the next beat, press
Tab and your last entry will be reproduced.

•  Adding ties: Press T and a tie will appear after the note you have just
entered or in between notes previously entered. The notes must be the
same pitches or Igor Engraver will create a shortened tie that appears to
end before the next note.

• Creating a pick-up bar: To create a pick-up bar, simply don’t fill the bar
completely but advance to the next bar, using the right arrow.

•  Entering tuplets and sticky tuplets: Enter a note and then press
Alt/Option-3. If you have consecutive triplets you may want to use the
sticky triplet option. After entering the first triplet, press Alt/Option-Shift-

1 – you will be able to enter consecutive triplets until you tell Igor
Engraver to stop by repeating Alt/Option-Shift-1.

• Changing barlines: Press I until the appropriate barline is displayed.
•  Changing noteheads: After entering a note, and press N until the

notehead you want appears.
•  Adding entry text: While in Input mode, press : (colon). A box will

appear and you can type your text, such as pizz.
•  Entering grace notes: Press Alt/Option-G and you will be in Grace note

mode (you will see a slash through the note in the Music Entry window);
to exit Grace note mode press Alt/Option-G.

•  Entering courtesy accidentals: Right/Control-click the desired note,
select Accidental mode and choose from the options displayed.
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•  Inputting music in different layers: If you want several independent
voices on one staff (as in choral music), you should work in different
layers. Press Alt-Shift-2 (Win) or Control-2 (Mac) to move to the second
voice of a staff, and input your music. Press Alt-Shift-3 (Win) or Control-3

(Mac) to get a third layer, and so forth. Press Alt-Shift-1 or Control-1

respectively to return to the first layer. Note that the first layer should be
the upper voice – otherwise the stems of the notes will be pointing the
wrong way.

• Using mirroring: After entering one voice you can mirror the rhythms of
this voice into another by pressing O (lower case o) – you will see the
word “Mirroring” in the Music Entry window. After pressing, move to
another staff or layer and choose the pitches you want. Igor Engraver will
use the rhythms from the staff you have chosen, so there is no need for
entering them again – a feature which saves you a lot of time. To leave
Mirroring mode, press O again.

Using Contextual Menus
1. Right-click (Win) or Control-click (Mac) on any object (ranging from

staccato dots to entire pages) in your piece and a contextual menu pops
up, in which you will see the options to modify the object. Note that if
several objects are selected
(via click-dragging or
Sh i f t - c l i ck ing ) ,  th e
contextual menu applies to
all of them.

2 .  F o r  e x a m p l e ,
Right/Control-click on a
note and the options might
be:

READ MORE: Igor Engraver Manual, Chapters 2, 3, 7, 10
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Delete note, Set colour of note, Ottava passage, Show/hide, Mute playback,

Set duration, Stem direction, Accidental mode, Slash notation, Cross staff,

Scale note.
A few of the many other objects of interest:
•  articulations: Right/Control-click an articulation marking to add an

extension or to flip it.
• bars: Right/Control-click on an empty spot in a bar to glue it in place

or to move it to another system.
•  staves: Right/Control-click on an empty spot in a staff to hide

(suppress) or show empty staves in the specified system.
• pages: Right/Control-click on an empty place in a page and you will

be allowed to move individual systems from page to page.
Furthermore, you will be able to insert e-commerce graphics (see the
manual for details).

Playing Back and Recording

Playing Back
If you do not see a window titled “Play and Record”, go to the Windows
menu and scroll down to and choose Play and Record. In this window, you will
see the bar in which the Input caret is located. Much like a tape recorder,
from left to right the options are: go back to first bar, move back one bar,
play, pause, stop, move ahead one bar and move to the last bar. If you would
like Igor Engraver to start in a different bar, move the Input caret to this bar
or click on the box in the lower left corner of the Play and Record window
and type the number of the bar in which you would like playback to begin.

READ MORE: Igor Engraver Manual, Chapters 9, 10, 17
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Step-Time Recording with a MIDI Keyboard
(Please see the manual for Real-Time Recording.) Step-time recording
provides a very efficient way of inputting your music. This is how it’s done:
1.  Place the input caret in the bar where you would like to enter your

music.
2. Choose the desired note duration, play the pitch/pitches on the MIDI

keyboard and then press Enter. The pitch or the chord will be displayed
with the duration you have chosen. Observe that your MIDI Input
settings must be correct.

Adding Text

Adding Lyrics
1. To enter Lyrics mode, place the input caret (in Input mode) after the first

note and press Shift-Space. Type the text and then press Space. The text
box moves to the next note. Enter the next word.

2. If your word has more than one syllable, type - (hyphen) between the
syllables, one or several times.

3. To add an extender, press _ (underscore). For an extender under more than
one note, just keep pressing underscores.

Text Entry
1. On the Tools palette click on the Textbox Tool.
2. You will see five options for text entry:
3. Page Text: this is used for titles, composer, arranger, etc.
4. System Text: this is used to enter tempos and will affect playback. If you

choose to use this option in a blank bar, Igor Engraver will ask where
the text box should be placed. For
example, if you are in 4/4 and would like
the text box to be placed on the third

READ MORE: Igor Engraver Manual, Chapters 1 (OMS), 4, 16
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beat, type 2/4. (The units are mathematical – the first beat is 0.) The
text you enter will appear only at the top of a system in the score layout,
but in all of the part layouts.

5. Staff Text: this creates a textbox that is attached to a specific staff and
does not affect playback. You can use staff text for chord symbols,
special instructions, and so on.

6 .  Entry Expressions: this tool creates a textbox that is attached to a
specific entry (note, chord, or rest). Many terms will affect playback
behaviour. Some examples are: pizz, pizz., arco, mute, staccato, sord, etc.
(Please see the manual for a complete listing, and note that punctuation
can be used.)

7. Rehearsal Marks: like system textboxes, these will appear on the top of a
score layout and on all of the part layouts. The appearance of the
enclosure of rehearsal marks can be defined in the Piece Settings.

8. Choose the appropriate textbox. Depending on your selection, click on
the note, bar, or section of the page where you would like to enter text.
(Page text areas are defined via click-dragging.)

9. Type in your text (press Alt/Option-Return to add more rows of text) and
press Return or click outside the textbox when you are done.

10. To edit the style of text you have just entered, click on it once. You will
see a box around the text and the Font menu will appear on the menu
bar. From that menu, you can change the font, size and style. (Note that
text fonts can be changed at any time in the Piece Settings. We strongly
recommend you to change them to something more suitable than the
default ones.)

11. To edit the text itself, double-click and retype.
12. The text boxes can be moved with the arrows (if selected) or the mouse.
13. If you have entered a tempo marking, but are not pleased with the tempo

Igor Engraver has chosen, Right/Control-click the text and choose Set

system text tempo. In the window that appears, choose a new tempo and
click on Set.

READ MORE: Igor Engraver Manual, Chapters 3, 11
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Changing Music Fonts
Igor Engraver supports many of the most used third-party music fonts,
including certain jazz fonts. To use another font for your music, scroll down
to the Music font pane in the Piece settings. The ones that are available in
your fonts folder and are supported by Igor Engraver will be displayed. If
changed, the font of your music updates instantly.

Changing the Size of Your Music
1.  Under the Layout menu, scroll down to Layout Settings. (The Layout

Settings can also be opened by dragging a layout to the Settings icon in
the Piece window.)

2. Click on the pulldown menu that reads Basics, and choose Format.
3. Choose the new size of your music. 1 is 100%, 0.7 is 70% etc.

To change the size of the music for only one musician, do the following:
1. Open the Piece window.
2. Open the Musician Settings by dragging the Musician to the Settings

icon.
3. Set the “Scale musician” number to, for instance, 0.7.

Adding Tab
1. Right/Control-click a bar and choose Add Tab to this staff.
2 .  You will see that

tablature has been added
below the music that had
been previously entered.

READ MORE: Igor Engraver Manual, Chapter 10

READ MORE: Igor Engraver Manual, Chapters 2, 3, 6, 7, 8



– 18 –

3. If you decide that you have entered a wrong pitch, click the pitch and use
the arrows to change it. You will notice that the tab numbers will also
move.

4 .  Igor Engraver has the world’s most advanced guitar and tablature
features. See Chapter 12 of the manual for more details.

Technical Support
1. If you have questions regarding specific areas of the software, try turning

on balloon help, which is especially useful for quick reference of different
settings.

2. Extensive technical support, as well as tutorials, are found in the Igor
Engraver manual. Note that there is a trouble-shooting appendix that
answers most commonly asked questions.

3 .  If you don’t find an answer to your question there, you can contact
support@noteheads.com.

4.  We recommend that you join the NoteHeads Community (follow the
Community link on www.noteheads.com) to access forums, chat rooms
and Igor Engraver tips. Joining is free!

Moving On
By now, you have got a taste of the ease and flexibility of Igor Engraver. Of
course, as there are so many features in this program, we couldn’t
communicate all of them to you in a QuickStart Guide. Instead, we
recommend you to experiment with Igor Engraver and consult the manual
when you need to. Also, be sure to watch the QuickTime movies (Introduction
first) found on www.noteheads.com/igor to get started even faster!

Remember also that Igor Engraver is only one of the services that NoteHeads
provide for you as a musician. Other services include:

READ MORE: Igor Engraver Manual, Chapter 12
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•  NoteHeads Community: the NoteHeads Community is the most
elaborate online community for performing musicians, publishers,
music educators, and engravers. We offer you your own, unique and
FREE customisable homepage (www.noteheads.net/yourname)
where you can present yourself and even sell your music!

• Igor Reader: the free Igor Reader is used for viewing files that have
been exported from Igor Engraver to the cross-platform IGP (Igor
Publishing) format. These sheet music files not only allow viewing
and printing but also offer playback functionality.

• The Music Stand: the Music Stand is the online sheet music shop of
noteheads.com. Here, IGP files can be downloaded in a demo state,
viewed by the Igor Reader, and then bought.

•  NoteHeads Commerce: NoteHeads Commerce is a secure online
sheet music distribution system aimed at large publishers, who
want to create their own online sheet music shops.

•  Enhanced CDs: An enhanced CD contains, as well as the usual
audio content, sample IGP files of the sheet music for the titles on
the disc. If the viewers/listeners then want to buy the parts in their
entirety, they follow a link to the web site where they can do so.

Find out more about our offers at www.noteheads.com today!
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For further information, contact:

NoteHeads AB
Grevgatan 22

114 53 STOCKHOLM

SWEDEN

Tel: +46 8-50 30 33 00

Fax: +46 8-50 30 33 29

NoteHeads USA
178 Ledyard St.

New London, CT 06320

USA

Tel: 860/444-2862

Fax: 860/443-6866

Or visit us on the Internet:
www.noteheads.com
info@noteheads.com


